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Overview

This article will walk you through the steps to create a printed walk list with specific questions (attribute check-boxes) for your door-knockers to
check off — some examples of what these questions would be: do you support the candidate, undecided, doesn’t support, wants a yard sign, wasn’t
home, wants to volunteer, misc. hot button issues, etc.

By default the walk list will contain a lot of information about the voters you’re going to canvass (e.g. name, gender, precinct, districts, full address,
Reg ID, county, and more). A lot of this information can be removed (covered in section #2).

After creating your walk list questions the article will show you how to target a list of voters (by things like vote history and location), and print the
paper walk lists to include the questions you created.

The final section shows how to re-enter the data (walk list results) in batch mode.
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« Tip: If you prefer to use our mobile app to canvass voters, read this article (this will save you time and paper resources — this option *requires a

consistent internet connection to work).

Outline

#1 Create Attributes (Questions) for the Walk List

#2 Create and Save the Format (Grid with Columns) to Include your Questions (Attributes), and Run a Test Print
#3 Build and Run a Targeted Search Query for the Voters you want your Door Knockers to Canvass

#4 Generate and Print the Walk List ‘Selectable Format’ and Begin Door Knocking

#5 Re-Enter the Walk List Results in ‘Batch Mode’ (Directly into the Grid)

#6 Related Resources

#1 — Create Attributes (Questions) for the Walk List
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« Tip: For an in-depth walkthrough on how to create attribute folders and items, along with many examples of what they’re used for, read this
article.

Navigate to the Voters list under the Application Menu.
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—

@) Settings Help

Application Menu &«
i

Tasks =

B Dashboard
[» % Committee
5 Calendar/Tasks
[ % Canvassing
4 % Voter
Yoters -‘—

Minnesota Voter List
@ Addresses
@ Households
Yoter Relationships
FJ Lawn Signs
€z shared Databases
|- @@ Contributions/Pledges
5 7 Product Sales
[» @ Logs
7 Polling
[ @ Communications
[ 5 Financial
[ % Disclosure
i &g System Manager

Navigate to the Attribute tab and click the [Magnify] button on the right to open the attribute tree in a larger window.
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<3 Search ¥ Reset |4k New [S|E = ) CF @ | File - Edit - | & | SpInclude Other | Voters

2. Magnify the

_ ||attribute tree.
)

Q 1
Favorites | General | Address | Household | Vote History | Attribute §Canvass | Poll | Relation | Lawn Sign | Contribute | Pledge | Event | Sales | Log | Admin| SQL |
Include | Exclude |
Qo
In precisely Attribute Yes Date From Date To Note - |
© In at least B = & attributes
In range
Inal F  Available Media Outlet "1
[ Campaign Rol i
e e —— -
of D selected {0 Canwvassing Scripts
[+ Contact Preference il

[ Expand this list into a larger pop-up form h

EE Edit |@Sort @Format - 53 Wrap |DE Export &Print |E Summary D] B |Pivot |

= Last First Address . Zip Birth Gen- Reg
D T My ME| Tone Street Street 2 City State ‘oo e ger  County CD 5D LD e
E o

Right-click on the ‘Attributes’ folder at the top of the tree and select ‘Insert Folder...".
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1. Right-click on the top-most "Attributes’ folder to bring
up the context menu.

(®

Attribute
D| = fm Attributes
H- Available Media Outlet
H-= Campaign Roles
H-—) Canvassing Scripts Insert folder... t fOlde F... ' o
H-=1 Contact Preference Insert item (attribute)...
H-—  Direct Mailings Properties ...
-1 Donor Level Rename ..
F-{—) Lawn Sign Requests Delete ..
H-— Mobile Canvassing Quest TSERpE e
F-— Mot - Hidden/&rchived Records
- Place your order
H-—) Poll Watch - General 2018
F-  Poll Watch - Primary 2016
H-—1 Poll Watch - Primary 2018
F-— Poll Watch - Runoff 2016
- Social Metworking
- Source
U4 Volunteers
- Voter Candidate Support
H-—h  VoterIssues

Check all children
Uncheck all children
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Give the folder a name, and click [OK]. In my example I called in 2017 Walk List Questions.
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Attribute

Available Media Cutlet

Date Fram

Campaign Roles

Canvassing Scripts

Contact Preference

Direct Mailings

Donor Level

Lawn 5ign Requests

Mobile Canvassing Ques]

Mot - Hidden/Archived Ry

Place your aorder

Poll Watch - General 2014

Poll Watch - Primary 201

Paoll Watch - Primary 201

Poll Watch - Runoff 201

Social Networking

Source

Create Mew Folder

New Folder

&- The new folder will be created in the “Attributes” folder.

MName: 2017 Walk List Qu estinns|

1. Create a name for the new
attribute folder.

Volunteers

Voter Candidate Support

Voter Issues
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Right-click on your new Attribute Folder and select ‘Insert item (attribute)...”.
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1. Right-click on the new attribute folder you created
and select ‘Insert item (attribute)...'.

e . R=RRCIN

Attribute Yes Diate From Date To Mote i

E-{ Attributes ] .

03 : Check all children »
H4—  Available Media Outlet
Uncheck all children

H{— Campaign Roles
F-h  Canvassing Scripts Insert folder...
H-{— Contact Preference |[ﬁ Insert itern (attribute)... z‘l
H-— Direct Mailings S8  Properties ...

F-— Donor Level Rename ...
-1 Lawn Sign Requests X Delete..
H{—1 Maobile Canvassing Questions - Script Mol
H{—1 Mot - Hidden/Archived Records

H-{—7 Place your order

H-{— Poll Watch - General 2018

F-—h  Poll Watch - Primary 2016

- Poll Watch - Primary 20138

H4— Poll Watch - Runoff 2016

4 Socal Metwaorking

H— Source

H-— WVolunteers

H-{— Voter Candidate Support

- Voter Issues
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Check the box in the lower-left of the input form to keep the form open (if you're entering multiple questions).

Create your questions, and click [OK] as you go. My example is below where | created a variety of questions about candidate support, if the voter
wants a yard sign, and if they want to contribute.

KNOWLEDGE BASE www.trailblz.com/kb 11



http://www.trailblz.com/kb

& TrailBlazer

Organize, Leverage. Succeed.

Walk List, Selectable Format — How to Create Paper Walk Lists with
Questions & How to Enter the Results in ‘Batch Mode’

2. Create questions for your
door-knockers to ask.

1. Check this box if you're

=] 22
F
Attribute Yes Date From Date To Mote = ;:f
E-h  Attributes il .

EI{E] 2017 Walk List Questions -

EE Doesn't Support Create Mew Attribute E

| New Attribute / |
=
EE Supports
= gi- The new attribute will be created in 17 Walk List Questions™ folder.

S8 Undecided

58 wants to Volunteer Mame: Wants to Contribute

%E Wants Yard Sign ) . )

Keep this form open so that additional attributes can be created. N
F-h  Available Media Outlet =
.. ! Questions”,
s Campaign Roles Attribute "Wants to Volunteer” created in folder 2017 Walk List
-7 Canvassing Scripts Questions”,
Attribute "Mot Home" created in folder "2017 Walk List Questions”,
[ Contact Preference
- Direct Mailings
F-h Donor Level 3
[ Lawn Sign Requests
#-— Mobile Canvassing Questi l OK I [@ Cancel ]
#-=7 Mot - Hidden/Archived R
[+ Place your order l "] L4
- Poll Watch - General ils il
-y Poll Watch - Primaqﬂﬂlﬁ il
H-=  Pall Watch - Primﬁ 2018 i
- Poll Wateh - Ruﬁfr 2016 "]
Fore .’ — o
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Once you're finished entering all of the questions, click the [Cancel] button, or the red [x] in the top-right of the input form to close it.
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When you're finished creating all of the questions click either the red [x]
in the top-right or the [Cancel] button to close the input form.

Attribute Date From Date To
E{—  Attributes

EI{E] 2017 Walk List Questions
%E Doesn't Support Create Mew Attribute

EE Mot Home Mew Attribute

i %E Supports
= gi- The new attribute will be created in the "2017 Walk List Questions™ folder.
EE Undecided

= Wants to Contribute Name:

%E Wants to Volunteer

Keep this form open so that additional attnibutes can be created.

EE Wants Yard Sign
Cuestions”,

bl T Attribute "Not Home" created in folder "2017 Walk List Questions”.
Campaign Roles Attribute “Wants to Contribute” created in folder “2017 Walk List
Questions”,

Canvassing Scripts

Contact Preference

Direct Mailings

Donor Level

Lawn Sign Requests [ OK I @CH"DE| 1

Maobile Canvassing Questio

Mot - Hidden/Archived Records

Place your order

Poll Watch - General 2013
Poll Watch - Primary 2016
Poll Watch - Primary 2018
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The new attributes will display in the tree. Click the red [x] in the top-right to close out of the expanded window. My finished example is below
with my new attribute folder and attribute items.
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Click the red [x] in the

Your new attributes (questions) that you'll use on the walk list top-right of the expanded
will now display in the attribute tree. window to close it.

Attribute Yes Date From
EI{E] 2017 Walk List Questions
EE Doesn't Support
%E Mot Home

%E Supports

N E

B8 Undecided

Wants to Contribute

EE Wants to Volunteer

EE Wants Yard Sign
Available Media Outlet

Campaign Roles

Canvassing Scripts

Contact Preference

Direct Mailings

Donor Level

Lawn Sign Reguests

Mobile Canvassing Questions - Script Mol
Mot - Hidden/Archived Records

Place your order

Poll Watch - General 2018
Poll Watch - Primary 2016
Poll Watch - Primary 2015

ore O IO e T IO e O O IO s T I e O I e O I e T O 1O e O I oy O Y OO0 W

O o o T
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The next section walks through the steps to add the attributes into the grid (list) so they print out on the paper walk list and so they are
updateable. It also will show you how to save the format for future use when you enter the walk list results in batch.

#2 — Create and Save the Format (Grid with Columns) to Include your Questions
(Attributes), and Run a Test Print

Navigate to the Voters list under the Application Menu.
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@) Settings Help
Application Menu

B Dashboard
[» % Committee
5 Calendar/Tasks
[ % Canvassing
4 % Voter
Yoters -‘—

Minnesota Voter List
@ Addresses
@ Households
Yoter Relationships
FJ Lawn Signs
€z shared Databases
;- Wi Contributions/Pledges
5 7 Product Sales
[» @ Logs
7 Polling
[ @ Communications
[ a Financial
[ % Disclosure
i &g System Manager

Click the [Format] drop-down and select ‘Columns...”.
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<3 Search Y. Reset |dpNew [S|E 0 ) ¥ @ 2| File~ Edit - | &  SgInclude Other | Voters |
Q
Favorites | General | Address | Household | Vote History  Attribute | Canvass | Poll | Relation | Lawn Sign | Contribute | Pledge | Event | Sales | Log | Admin| saL |
Inchude | Exclude |
Q
In precisely Attribute Yes Date From Date To Note | &
@ inatleas B Attributes 0 J »
In range :
Inal [ E-—3 2017 Walk List Questions |:| '@.
-‘ -. = i
tD —| EE Doesn't Support [
of 0 selected S8 Not Home
EE Supports =
EE Edit | B Sort [ Format - |53 Wrap |Ea Export &Plint | Summary m E |Pi'.r::-l |
oter Lis rto <System Format: aarc]
D |§ :::‘c':sl:ved ﬂ MI %‘:}‘:’“5 Street Street 2 City State ?3 e g::: g:r“ County CD SD LD :‘;9
0 B Save Add or remove columns, apply formatting, or specify column attributes.
W Savehs..
) Assign as default...

Navigate to the Attributes tab, check all the boxes under the Settings column for the attributes you created in section #1, and then navigate to the
Format tab.
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; 9 Column Selection 1 L__
C-Dlumnte History 3

Attributes

Tree Setting Date

E-=)  Attributes ]
=) 2017 Walk List Questions

EE Doesn't Support

%E Mot Home

%E Supports

~Bf Undecided

B wants to Contribute

%E Wants to Volunteer

%E Wants Yard Sign
Available Media Outlet

1|
OO

EEEEEE

Campaign Roles

Canvassing Scripts

Contact Preference

Direct Mailings

OOouooo oo @ o o
OO0O0oooooE@Ea@
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Scroll out to the right until the Updateable column displays.

Check all the boxes for the attributes you created, under the Updateable column, and click then [OK]. This is important prep work for the final
section of the article (re-entering walk list results in batch mode).

KNOWLEDGE BASE www.trailblz.com/kb 21



http://www.trailblz.com/kb

@ Lﬁgﬂé!ggazer Walk List, Selectable Format — How to Create Paper Walk Lists with
Questions & How to Enter the Results in ‘Batch Mode’

#) Column Selection

Columns | Attributes | Vote Histony
Format

&
[m—]
s

-
J
[=]
=4
m
=

Column Heading

Address [DefaultDisplay].CD D
Address [DefaultDisplay].5D sD
Address [DefaultDisplay].LD LD
Sec. of 5t Voter #

Doesn't Support Doesn't Support

Mot Home Mot Home

[
(Rl

]
E

Boolean

Boolean

Supports Supports Boolean
Undecided Undecided
Wants to Contribute Wants to Contr...
Wants to Volunteer Wants to Volu..,

Wants Yard Sign Wants Yard Sign

Boolean

Boolean

Boolean

Boolean
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The new attribute (questions) will be added to the far right of the grid. My example is below.
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<3 Search % Reset | <k New o6 o é File » Edit + | ) | SgInclude Other | Voters

Q
Favnr\tasl General Address | Househeld I Vote History | Attribute I Canvass I Poll I Relation | Lawn Sign | Centribute | Pledge I Eveml Sales | Leg I Mmlnl SaL I
Q
@ Address Types Address | Additional I Dishiml User I Tyml
[T] Default Display Nation: [ - -
(] Mailing )
[¥] Main Home LN Address:
[T Main \work
[] Other Home
[ Other Work
[ Registration City: Minneapolis -
Current Addresses State
Zip Code: o . .
The new attribute columns will be added

to the far right of the grid.

gé Edit @ Sort @ Format -~ =3 Wrap aa Export &Pnnt [ Summary Dj B
ptel 68 records found
D Nome R M |fpe Steet steet2 City sote e pate  ae Cow @ oo @ | QORRL B0, swpors  Undecded GRS Vdumeer  ord Sign
r WY ™ [ [ - I [ -
134... | Ajayi Shawntrice @ | 4638 Emerson Ave N Minneapolis | MN | 55412 1/1/1984 Henn.. |005 |59 594 |3660536
352 Albright Lynn Ko.. @ 3218 Humboldt Ave N Minneapolis MM 55412 1/1/1954 F Henn.. |05 |59 |59A 351734
236.. | Amundson | Alyson M... @ 3643 Knox Ave N Minneapalis | MM 55412 1/1/1980 F Henn.. |05 |59 594 1499454
6819 | Amundson | Thomas Da.. @ 3643 Knox Ave N Minneapalis | MM 55412 1/1/1979 M Henn.. |05 |59 |59A 1523425
712 | Anderson Bruce Ch.. @] 290 Washburn Ave N Minneapolis | MN 55405 1/1/1952 | M Henn.. |05 |59 |59B |1071676
852 Anderson Ginger Lee @ 4101 Thomas Ave M Apt 10 Minneapolis MM 55412-1557 1/1/1958 | F Henn.. |05 |59 | 59A |1155879
Anderson Jerry Lee @ 3245 Sheridan Ave N Minneapolis MM 55412 1/1/1951 | M Henn.. |05 |59 |59A 3572413
Andrus Susan Lynn @ 45 University Ave SE Apt 203 Minneapolis MM 55414 17171970 | F Henn.. |05 |60 G0B | 1433644
Angel Darla Kay @ 5218 Irving Ave N Minneapolis MM 55430 1/1/11963 | F Henn.. |05 |59 |59A 3925569
Antonson Sandra M. @ 2634 34th Ave 5 Apt 2 Minneapolis MM 55406 1/1/1963 | F Henn.. |05 |63 |63A 1596402
Archer James Cly... @ 1015 Queen Ave N Minneapolis MK 55411 1/1/1980 M Henn.. |05 |59 |59B 1453377
Armstrong Frank Lee @ 1927 Upton Ave N Minneapolis MM 55411 111963 M Henn.. |05 |59 |59B 1596103
Armstrong Keyonna Sh... @ 909 Russell Ave N Aptl Minneapolis MM 55411 1/1/1980 Henn.. |05 |59 |59B 1576203
Armstrong | Michael Ja., @ 1203 1/2 3rd St NE Minneapalis | MM 55413 1//1979 M Henn.. |05 |60 | 60A | 2309082
Arons Maonica SU, @ 219 Morgan Ave M Minneapolis MM 55405 1/1/1956 | F Henn.. |05 |59 |59B 1109610
Atteberry Stuart Fr... @] 44373 Cedar fve S Minneapolis MM 554073827 1/1/1974 | M Henn.. |05 |63 |63B |1492372
Augusta Fazayah Ro... @ 3500 Emerson Ave S Apt 304 Minneapolis MM 55408 1/1/1981 | F Henn.. |05 |61 |61B |3609708
Bachman Joshua Aa. @ 1947 Lincoln 5t ME Apt 2 Minneapolis MK 55418 1/1/1984 | M Henn.. |05 |60 G0A |3525622
Bailey Leigh Hull @ 5428 Oliver Ave 5 Minneapolis MM 55419 1/1/1957 | F Henn.. |05 |61 | 61B 956802
Bakken Amy Eliv. @ 3614 Xences Ave N Minneapolis MM 55412 1/1/1967 | F Henn.. |05 |59 |59A 1003250
Bakker Sara Kriv @ 4511 Snelling Ave Minneapolis MM 55406 1/1/1981 |F Henn.. |05 |63 |63A 3776714
Bakuzis Andrejs Ja.. @ 2215 Pleasant Ave 5 Minneapolis MK 55404-3234 1/1/1953 Henn.. (005 |62 |B2A 1056545
449, Ballard-W. Tamarg Jean A 3500 3rd Ave S Minneapolis | MN 55408 141959 |F Henn 05 162 628 (1087137
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In order for the data to fit properly onto the paper walk lists you’ll need to widen the different attribute columns, and remove columns that

aren’t important to your door-knockers.

If you’re targeting a list of voters in the same state, city, county, district, etc. you really don’t need that data to display, so you can save room by
removing those columns. It’s also not likely that you need the Trail Blazer ID, Middle Name, Address Type, Reg ID, Zip Code, Gender and possibly

others.
To remove these columns, simply click on the column title(s) and select Hide.

To widen the columns so the data displays properly you’ll drag the vertical divider left-and-right, or you can double-click the divider to
automatically widen it. My finished example is below.
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<3 Search ¥, Reset | df New |[S|E ™ | 1) OF ¢ (2| File + Edit - | ) | SgInclude Other | Voters

Q
Favorites | General Address | Household | Vote History | Atribute | Canvass | Poll | Relation | Lawn Sign | Contribute | Pledge | Event | Sales | Log | Admin| SaL |
0 1
@ Address Types Address I Additional I Dish’ictl User I Typesl
] Default Displ o
%Mailil;g R L [ ] .
[¥] Main Home . Address:
[T] Main Work
[] Other Home
Other \work
Registration City: Minneapolis -
Current Addresses .
State: i mn titles and select 'Hide' for
Zip Code: 2

Detail |[@] Summary D] B |

8 Edit | B Sort () Format ~ =3 Wrap |DE Export &Prin

piel bé records found

important to print out on your paper walk list.

[ ¥ - P B R o A S W

Last Name First Name %‘:}fess Street Street 2 City Doesn't Support Mot Home Supports Undecided ‘Wants to Contribute ‘Wants to Volunteer ‘Wants Yard Sign
| 2 Sort Ascending (0-9) [ [ [ [ [ [ [
Ajayi Shawntrice IF  Sort Descending (9-0) Minneapolis
Albright Lynn — Minneapolis
Amundson Alyson X Minneapalis
Amundson Thomas BUMMAIES Minneapolis
Anderson Bruce Hide Minneapolis
Anderson Ginger Undo Last Hide Apt10 Minneapolis
Anderson Jerry Rename... Minneapalis
Andrus Susan ) Apt 203 Minneapolis
Angel Darla Eonfioure Minneapolis
Antonson Sandra @ 2634 34th Ave 5 Apt 2 Minneapolis
Archer James @ 1015 Queen Ave N Minneapalis
Armstrong Frank @ 1927 Upton Ave N Minneapolis
Armstrong Keyonna @ | 909 Russell Ave N Aptl Minneapolis
Armstrong Michael @ |12031/23rd StNE Minneapolis
Arons Monica @ 219 Margan Ave N Minneapalis
Atteberry Stuart @ 4473 Cedar Ave 5 Minneapolis
Augusta Fazayah @ 3500 Emerson Ave 5 Apt 304 Minneapalis
Bachman Joshua @ | 1947 Lincoin St NE Apt 2 Minneapolis
Bailey Leigh @ | 5428 Oliver Ave S Minneapolis
Bakken Amy @ 3614 Xerxes Ave N Minneapolis
Bakker Sara @ 4511 Snelling Ave Minneapalis
Bakuzis Andrejs @ 2215 Pleasant Ave S Minneapolis
[¥] | Ballard. Tamara [ 3500 3rd Ave 5 Ii i I il [ [ il [ I
E 568 1] 1] 0 (i} 1] [} 1]
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Once you're satisfied with what data will print out on your walk list (most importantly: name, address, and the attribute questions), it's a good
idea to run a quick print preview of the walk list to verify it will work (display properly on paper). You’ll want to do this prior to printing it,
distributing it to your door-knockers, and saving it as a format.

Click the [Reports] button in the bottom-right of the screen, select Walk List Selectable Format, and click [OK].
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Run a test print preview of the walk list to verify the format you created fits
on paper correctly.

= ile = it -
<5¢ Search Y. Reset | <F New o IEH*S File = Edit 7] &Include Other | Voters [
Favorites | General Address | Household | Vote History | Atiribute | Canvass | Poll | Relation | Lawn Sign | Contribute | Pledge | Event | Sales | Log | Admin| SL |
Q
@ Address Types Address | Additional | District | Mesc) Tuncal
[] Default Display B Naton: Qe Select a report to print B | E@M
[] Mailing ’
[¥] Main Home E Address: Reports
[] Main Vwork Simple List
& List with User Fields
List with MNotes
- B SN Simple Volurteer List
Registration City: Minneapol Volunteer List
/| Current Addresses . — Fundraising List
State: Labels (Use Avery 5160)
Zip Code: Labels (Use Avery 5160)/Nick Name Option
- Labels Name buitt by list-Combined House or by last name and address (Use Awver I
Labels Household and Envelope Name (Use Avery 5160)
MName Badge - First + Last Names + Employer (Use Avery 5352) N
Name Badge - First + Last Names (Use Ave 3
=8 Edit Sort Format ~ 53 Wrap | 5% Export Print De Wallc List_Selectable Format
g & sort £ 553 Wrap | &} Bxport & | Walk List, Voter History
I [Legacy] Walk List, Simple, 2 Checked I
[Legacy] Walk List, Simple, 5 Checked 2
; [Legacy] Walk List, Wide, 5 Checked ’ } ) &
Last Mame < First Mame Street [Legacy] Walk List, Satinder fdecided ‘Wants to Contribute ‘Wants to Volunteer Wants Yard Sign D
3 Aaron Shirley 1430 Newton Ave N I {Lfg:g} w:”: E:tt: g”pﬁﬁf s I F = & &
Ajayi Shawntrice 4638 Emerson Ave N {Lﬁaw} ﬁa”: Iljst. mdg EM‘F'b}I;rteso
i acy] Walk List, Attributes Yukon Options
Albright Lynn 3218 Humboldt Ave N [Legacy] Walk List, & Checked with barcade
Amundson Alysan 3643 Knox Ave N [Legacy] Walk List, Barcoded General Purpose
Amundson Thomas 3643 Knox Ave N
Anderson Bruce 290 Washburn Ave N 3
—_—
F i - F F 5 [l
Anderson Ginger 4101 Thomas Ave N [@ oK ]I’@Canoel l:
Anderson Jerry 3248 Sheridan Ave N =
Andrus Susan 45 University Ave SE Apt 203 Minneapolis [l (il |esl
Angel Darla 5218 Irving Ave N Minneapolis
Antonson Sandra 2634 34th Ave 5 Apt 2 Minneapolis
Archer James 1015 Queen Ave N Minneapolis
Armstrong Frank 1927 Upton Ave N Minneapalis
Armstrong Keyonna 909 Russell Ave M Aptl Minneapalis
Armstrong Michael 1203 1/2 3rd St NE Minneapolis
Arons Monica 219 Morgan Ave M Minneapolis
eberry ua edar Ave inneapaolis
Atteb Stuart 4423 Cedar Ave 5 Mi l il
13| 563 | | 0 | 0 | o | 0 | 0 | 0 |
< | m L | »
Logon=  Joel Kristenson |H Save | |bﬂ Save and Close @ Reports I e New ] ’@Canoel ]
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Give the test walk list a name, configure your options (or just leave them as default for the time being), and then click [OK].

Walking List

Heading
‘Report Title: ! Test of 2017 Walk List - Minneapolis|

Legend Text 1:
Legend Text 2:
Legend Text 3:
Legend Text £:

Dietail
Format: < displayed format:

Options 2. Configure

Print grid lines i
Oddleven order your ﬂptlﬂns.

[] Mew page when odd/even type changes
[] Mew page on street change
[] Start new street on odd page
[] Skip household when phone numbers missing

3

pr——
@ ok ]!@Cano&l |
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Verify that the data prints out correctly on your test print.

You'll likely want to click the [Print Settings] button at the top and adjust the margins, as well as change the orientation to landscape so that
everything fits correctly. My test walk list is below with all the data formatted properly.
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You'll likely want to adjust the margins and the change the orientation to ‘Landscape’ under the
[Print Settings] menu. \

. & (B EE e - N N r r
&Pt | B 2 |Bgless GEMore [Q Q1 © Q | & print Settings Verify your questions (attributes) and other data fits on the paper
walk list correctly. /\
& TrailBlazer
Test of 2017 Walk List - Minneapolis Page: 1 of 32- 3/3/2017 2:25 PM
Last Name First Name Doesn't Support Not Home Supports Undecided Wants to Contribute Wants to Volunteer Wants Yard Sign
1508 10th Ave S, Apt 4, Minneapolis, MN 55404 [Precinct Code=1620, Precinct Name=MINNEAPOLIS W-6 P-04]
McGarrity Sean ] ] | 1 ] 1 ]
5404 10th Ave S, Minneapolis, MN 55417 [Precinct Code=1885, Precinct Name=MINNEAPOLIS W-11 P-06]
Breece Alyssa ] | ] 1 1 1 ]
6016 10th Ave S, Minneapolis, MN 55417 [Precinct Code=1890, Precinct Name=MINNEAPOLIS W-11 P-07]
Vogt dohn [ O 0 O O d 0
2900 11th Ave S, Apt 1013, Minneapolis, MN 55407 [Precinct Code=1760, Precinct Name=MINNEAPOLIS W-9 P-03]
Dankers Dawn ] ] ] | ] | ]
4025 11th Ave S, Apt B, Minneapolis, MN 55407 [Precinct Code=1735, Precinct Name=MINNEAPOLIS W-8 P-08]
Pryce Victoria 1 Fl F] F 1 F 1
4013 11th Ave S, Minneapolis, MN 55407 [Precinct Code=1735, Precinct Name=MINNEAPOLIS W-§ P-08]
Domin Jessica ] | Fl | Il | 1
Domin Ryan ] Fl Fl ] [l Fl ]
221 12th Ave NE, Minneapolis, MN 55413 [Precinct Code=1485, Precinct Name=MINNEAPOLIS W-3 P-06] L
Hollingsworth Allen 1 | A F 1 F d 1
3923 12th Ave S, Minneapolis, MN 55407 [Precinct Code=1735, Precinct Name=MINNEAPOLIS W-8 P-08]
Holloway Brian O H O | O | .l
6044 13th Ave S, Minneapolis, MN 55417 [Precinct Code=1890, Precinct Name=MINNEAPOLIS W-11 P-07]
Parker William [] | ] | 1 | )
2101 13th Ave S, Minneapolis, MN 55404 [Precinct Code=1625, Precinct Name=MINNEAPOLIS W-6 P-05]
St Clair Penny [l Fl ] F 1 F ]
2923 13th Ave S, Minneapolis, MN 55407 [Precinct Code=1760, Precinct Name=MINNEAPOLIS W-9 P-03]
Strickland Keith 0 Fl O F] | F] F]
815 13th Ave SE, Apt 205, Minneapolis, MN 55414 [Precinct Code=1460, Precinct Name=MINNEAPOLIS W-3 P-01]
McLaughlin Heather ] F ] | 1 ] ]
18 13th St N, Apt A305, Minneapolis, MN 55403 [Precinct Code=1680, Precinct Name=MINNEAPQOLIS W-7 P-08]
Wilson Lawrence O Fl F ] ¥ F ]
3957 14th Ave S, Minneapolis, MN 55407 [Precinct Code=1735, Precinct Name=MINNEAPQOLIS W-§ P-08]
Walvatne Matthew [l O O | O | i
2536 14th Ave S, Minneapolis, MN 55404 [Precinct Code=1760, Precinct Name=MINNEAPOLIS W-9 P-03]
Kay Lisa O O O | L | O
317 15th Ave NE, Apt 10, Minneapolis, MN 55413 [Precinct Code=1485, Precinct Name=MINNEAPOLIS W-3 P-06]
Crews Shantie 1 [l ] 1 1 F 1
4415 15th Ave S, Minneapolis, MN 55407 [Precinct Code=1875, Precinct Name=MINNEAPOLIS W-11 P-04]
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Click [Cancel] in the bottom-right to return back to the grid.
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¢ Print | J¥ J=& EE Less EE More 0 Q 1 e 0 ;\EPrint Settings
& TrailBlazer
Test of 2017 Walk List - Minneapolis Page: 1 of 32 - 3/3/2017 2:25 PM
Last Name First Name Doesn't Support Mot Home Supports Undecided Wants to Contribute Wants to Volunteer Wants |
1508 10th Ave §, Apt 4, Minneapolis, MN 55404 [Precinct Code=1620, Precinct Name=MINNEAPOLIS W-6 P-04]
McGarrity Sean ] ] ] | | |
5404 10th Ave S, Minneapolis, MN 53417 [Precinct Code=1885, Precinct Name=MINNEAPOLIS W-11 P-06]
Breece Alyssa J Fl | | ¥ F
6016 10th Ave S, Minneapolis, MN 53417 [Precinct Code=1890, Precinct Name=MINNEAPOLIS W-11 P07]
Vogt John O Fl O O O F
2900 11th Ave §, Apt 1013, Minneapolis, MN 55407 [Precinct Code=1760, Precinct Name=MINNEAPOLIS W29 P-03]
Dankers Dawn ] ] F] ] | ]
4025 11th Ave S, Apt B, Minneapolis, MN 55407 [Precinct Code=1735, Precinct Name=MINNEAPOLIS W-8 P-08] L
Pryce Victoria ] |l ] | | | 1
4013 11th Ave S, Minneapolis, MN 53407 [Precinct Code=1733, Precinct Name=MINNEAPOLIS W-8 P-08]
Domin Jessica 1 Fl | | | Fi
Domin Ryan [] ] F] F] | |
221 12th Ave NE, Minneapolis, MN 55413 [Precinct Code=1483, Precinct Name=MINNEAPOLIS W-3 P-06]
Hollingsworth Allen ] Fi ] Fl | F]
3923 12th Ave S, Minneapolis, MN 53407 [Precinct Code=1733, Precinct Name=MINNEAPOLIS W-8 P-08]
Holloway Brian O F O O O F
6044 13th Ave S, Minneapolis, MN 55417 [Precinct Code=1890, Precinct Name=MINNEAPOLIS W-11 P-07]
Parker William ] ] F] F] | ]
2101 13th Ave S, Minneapolis, MN 55404 [Precinct Code=16253, Precinct Name=MINNEAPOLIS W-6 P-05]
St Clair Penny ] F ] | | |
2923 13th Ave S, Minneapolis, MN 55407 [Precinct Code=1760, Precinct Name=MINNEAPOLIS W-9 P-03]
Strickland Keith O Fl F] Fl O Fl
815 13th Ave SE, Apt 205, Minneapolis, MN 55414 [Precinct Code=1460, Precinct Name=MINNEAPOLIS W-3 P-01]
McLaughlin Heather [] [ F] 1 1 1
18 13th St N, Apt A305, Minneapolis, MN 55403 [Precinct Code=1680, Precinct Name=MINNEAPOLIS W-7 P-08]
Wilson Lawrence ] Fl ] Fi | Fi
3957 14th Ave S, Minneapolis, MN 55407 [Precinct Code=1735, Precinct Name=MINNEAPOLIS W-§ P-08]
Walvatne Matthew O Fl | | O Fl
4 BE— B - B : - - _rrr- = e e e
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If further changes are needed to make the data fit on your walk list properly (removing more columns, or modifying column widths), you’ll want to
make those changes now. In my case the data fit on paper so it’s time to save the format for future use.

Once you're satisfied that everything fits onto paper correctly, click the [Format] drop-down on the tool strip above the grid, and select ‘Save As...".

KNOWLEDGE BASE www.trailblz.com/kb 34



http://www.trailblz.com/kb

& TrailBlazer

Organize.Leverage. Succeed. Walk List, Selectable Format — How to Create Paper Walk Lists with
Questions & How to Enter the Results in ‘Batch Mode’

Once your format displays the data you need you'll want to save it
for future use. Click [Format] > Save As...

<3 Search %, Reset | dk New o= b O @ File » Edit + | ) | §gInclude Other | Voters
Q

Favorites | General Address | Household | Vote History | Afiribute | Canvass | Poll | Relation | Lawn Sign | Contribute | Pledge | Event |

Address Types Address | Additional I Dish’ictl ser I T}rp&sl
Defzult Display s —

Mailing i Mation: [
Main Home Address:

Main work
Other Home
Other Wark
Registration

Current Addresses

Minneapaolis

¥

8 Edit ) Sort [ Format ~|=3 Wrap EE Export &Print |§| Summary [D E [E] Pivet |
=

Last Mz B Columns.. Street Street 2 City Doesn't Support
Aaron E elect saved. 1430 Mewton Ave N Minneapolis
Ajayi rIJ.IJaue ] 4635 Emerson Ave N Minneapolis
Albrigh##  Save As.. | 3218 Humboldt Ave N Minneapolis
Amurﬂ@ Assign as default... o 3643 Knox Ave M Minneapolis
Amundlsnn Thomas  Save the current format under a specified name l Minneapaolis
Anderson Bruce @ 290 Washburn Ave M Minneapolis 35
Anderson Ginger @] 4101 Thomas Ave M Apt 10 Minneapolis
Anderson Jerry @] 3245 Sheridan Ave N Minneapolis
P rr p—
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Give the format a distinguishable name, and then click [Save]. / called mine 2017 Walk List.

1. Give the format a name.

@ Save Format

{2017 Walk List]

@Eandida‘te Support Walk: ..
@ Employer Occupation

| |EE JAK DEFAULT

@ Phone Bank - Support
@Walk List Support

You can always come back and modify the format as necessary in the future (for instance if the door-knockers find out there is a hot button issue
that needs to be added as a new attribute). You'll reload this format in the final steps when you re-enter the results from the door knocking, and
you’ll use it in the next section when creating the paper walk list for your canvassers.

The next section walks through the steps to target a specific list of voters, print out the paper walk list, and record the results as you go door-to-
door.

KNOWLEDGE BASE www.trailblz.com/kb 36



http://www.trailblz.com/kb
http://trailblz.com/kb/?action=view&kb=272&cat=1

& TrailBlazer

Organtze.Leverage. Succeed. Walk List, Selectable Format — How to Create Paper Walk Lists with
Questions & How to Enter the Results in ‘Batch Mode’

#3 — Build and Run a Targeted Search Query for the Voters you want your Door Knockers to

Canvass

Open the Voters list.
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@) Settings Help
Application Menu

B Dashboard
[» % Committee
5 Calendar/Tasks
[ % Canvassing
4 % Voter
Yoters -‘—

Minnesota Voter List
@ Addresses
@ Households
Yoter Relationships
FJ Lawn Signs
€z shared Databases
;- Wi Contributions/Pledges
5 7 Product Sales
[» @ Logs
7 Polling
[ @ Communications
[ a Financial
[ % Disclosure
i &g System Manager

Build and run your search query for the voters you want to canvass.
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Typically you’ll start by targeting voters in a certain location. In this example | started by filtering the list by a specific precinct (NEW HOPE P-07)
which produced 2,743 results.
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Begin constructing your targeted list of voters - in this example I filtered by precinct name.

=ju Search . Reset | 9 New ™| EH ¥ é File - Edit » | 0 | SmInclude Other Voters |

Favorites | Genera] Address |[Household | Vote History | Attribute | Camvass | Poll | Relation | Lawn Sign | Ceniribute | Pledge | Event | Sales | Log | Admin] SGL |
@ |} Address Types Address | Additional District | User | Types|

ﬁ"“ Display &= | o + PrecinctMame:  NEW HOPE P{

ailing " S—
Main Home ® | D +  Precinct Code: -
Main \Work D - (I.'Dm_mi Halice

Other Home R

Other \work \wfard: City Council:
Registration Schoal-
Current Addresses

results

Format ~ =3 Wrap ma Export &Print @ Summary D] E

Voters [ 2743 records found |

ID 4+ LastName ;';ﬁ . MI ?;:J‘j; ®55 Street St'“t City State Eigd . g:ﬁ: g:r" County 0 SD LD Regld Precinct Name
3 I_ 93 Abts Brian Francis 8701 615t Ave N Mew Hope W 1/1/1965 ,M— Hennepin ,—,T,K 1487976 NEW HOPE PO7
a4 Abts Cari Lee @ 8701 61st Ave M Mew Hope 55428 1/1/1964 Hennepin as 45 458 1409304 MEW HOPE PO7
114 Belisle loan Kaye @ 6056 Rhode Island Ave N MNew Hope MM 55423 111964 F Hennepin 05 45 454 1273857 MEW HOPE P07
157 Adams Helen Ann @ 8008 Bass Lake Rd Apt721 | Mew Hope MM 55428 1/1/1908 | F Hennepin as 45 458 1048388 MEW HOPE PO7
277 Aho Anita L @'J 6043 Hillsboro Ave N Mew Hope MM 55428 141935 | F Hennepin 05 45 454 1149831 MEW HOPE P-O7
283 Aho Reuben Samuel @ 6043 Hillsboro Ave N Mew Hope MM 55428 1/1/1931 | M Hennepin as 45 458 1149832 MEW HOPE PO7
341 Albrecht Alison Faith @'J 6016 Quebec Ave M Mew Hope MM 55428 141978 | F Hennepin 05 45 454 1507235 MEW HOPE P07
345 Albrecht Maralee A @J 5209 Cavell Ave M Mew Hope MM 55423 1/1/1942 Hennepin 05 45 454 1152452 MEW HOPE PO7
375 Alexander Arnelda 1 @ 5856 Ensign Ave M MNew Hope MM 55423 1/1/1936 Hennepin 05 45 454 1142149 MEW HOPE P07
354 Alexander Leo E @J 5858 Ensign Ave M Mew Hope MM 55423 1/1/1932 | M Hennepin 05 45 454 1142150 MEW HOPE PO7
487 Allison Jeff David @'J 794060 1/2 Ave M Mew Hope BN 55423 141973 | M Hennepin 05 45 454 1264112 MEW HOPE P-OT
515 Almguist Marion Elizabeth @J 501e Decatur Ave N Mew Hope MM 55423 1/1/1925 |F Hennepin 05 45 454 1142065 MEW HOPE PO7
515 Almstrom Rebecca Renee @ 6064 Allan Cir Mew Hope MM 55428 141960 | F Hennepin 05 45 454 | 3516920 MEW HOPE PO7
519 Almstram Wayne Dale @'J o0a4 Allan Cir Mew Hope MM 55423 1/1/193 | M Hennepin 05 45 454 1585535 MEW HOPE PO7
&00 Amundsen Charles Robert @ 6050 West Broadway Apt7 Mew Hope MM 55428 141924 | M Hennepin 05 45 454 1153841 MEW HOPE PO7
601 Amundsen Viola M @'J 6048 West Broadway Apt1l5 | Mew Hope MM 55423 1141923 (F Hennepin 05 45 454 1153301 MEW HOPE PO7
671 Anderson Ann M @ 7240 60th Ave N Apt2l Mew Hope MM 55423 1/1/939 (F Hennepin 05 45 454 3794857 MEW HOPE PO7
711 Anderson Bruce A @ 8831 61st Ave M Mew Hope MM 55423 1/1/1965 | M Hennepin 05 45 454 | 1016704 MNEW HOPE PO7
789 Anderson Debbie Lynn @ 5831 61st Ave M Mew Hope MM 55425 1/1/1%:4 F Hennepin 05 45 454 1134855 MEW HOPE PO7
7495 Anderson Dennis Harold @ 5816 Hillsboro Cir MNew Hope MM 55423 1171939 | M Hennepin 05 45 454 1143326 MEW HOPE P07
797 Anderson Dennis Murphy @ 9010 61st Ave M MNew Hope MM 55423 1/1/1958 | M Hennepin 05 45 454 1227420 MEW HOPE PO7
813 Anderson Daris Tvadell @ 8003 Bass Lake Rd MNew Hope MM 55428-.. 111922 |F Hennepin 05 45 454 3280857 MEW HOPE P07
a1 p— e 1
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You’ll more than likely want to filter by voter history as well (this *requires you have voter history data loaded). In my example I filtered my list
further by any voter who voted in 1 of the last 3 general elections which brought the list down to 1,643.
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Walk List, Selectable Format — How to Create Paper Walk Lists with

Organize, Leverage. Succeed.
. . I ’
Questions & How to Enter the Results in ‘Batch Mode
You'll likely want to filter by voter history as well to go after things like your ‘super voters'.
This *requires you have voter history loaded in your database.
s Search %, Reset | 9F New = e File » Edit ~ | 0 | S Include Other Voters |
Fa\.lforites | General | Address | Household Vote History | Attribute | Canvass | Poll | Relation | Lawn Sign | Contribute | Pledge | Event | Sales | Log | Admin| SQL |
Inclu...  Election Vote Partisan i
11/06/2012-GENE... [voted | Not Partisar |
Onatlest [ o3 08/13/2013 - PRIM... Voted ~ | ot Partisar +|
08/12/2014 PRIMA... [Voted Mot partisar ~|
11/04/2014 GENER_ [Voted v Not Partisar | | |
Sk Edit | ) Sort B Format » 53 Wrap | ©% Export & Print -Detal (@) Summary (] =
results [

Voters [ 1643 records found ]

ID  ~ LastMame E':nE . MI %dpde'e“ Street St'“t City State Eigd . gia’t: g:f County 0 SO LD Regld Precinct Name
3 ’_ 93 Abts Erian Francis 8701 61st Ave N Mew Hope W 55428 1/1/1965 ’M_ Hennepin ’_’4‘?_’? 1457976 MEW HOPE P07
a4 Abts Cari Lee @ 8701 61st Ave N Mew Hope 55428 11194 F Hennepin a5 454 1409304 MEW HOPE P07
114 Belisle Joan Kaye @ 6056 Rhode Island Ave N Mew Hope MM 55428 11194 F Hennepin a5 45 454 1273887 MEW HOPE P07
277 Aha Anita L @ 6043 Hillsboro Ave N Mew Hope MM 55423 141935 |F Hennepin 05 45 454 1148831 MEW HOFE P07
283 Ahao Reuben Samuel @ 6043 Hillsbaro Ave N MNew Hope MM 55428 1141931 M Hennepin 05 45 454 1148332 MNEW HOPE P07
34 Albrecht Alison Faith @ G016 Quebec Ave N MNew Hope MM 55428 111978 |F Hennepin 05 45 454 1507235 MNEW HOFE P07
348 Albrecht Maralee A @ 5909 Cavell Ave N New Hope [ 55425 1111842 Hennepin 05 45 454 1152452 NEW HOPE P07
375 Alexander Arnelda J @ 5956 Ensign Ave N New Hope [ 55425 1111936 Hennepin 05 45 454 1142149 NEW HOPE P07
384 Alexander Leo E @ 5956 Ensign Ave N MNew Hope MM 55425 111832 M Hennepin 05 45 454 1142150 MNEW HOPE P07
518 Almstrom Rebecca Renee @ 6064 Allan Cir MNew Hope MM 55425 1//560 (F Hennepin 05 45 454 3516920 MNEW HOPE P07
519 Almstrom Wayne Dale @ G064 Allan Cir MNew Hope MM 55425 1/1/1963 M Hennepin 05 45 454 1595535 MNEW HOPE P07
a0 Amundsen Charles Robert @ 050 West Broadway Apt7 MNew Hope MM 55428 1/1/1924 M Hennepin 05 45 454 1153541 MEW HOPE P07
711 Anderson Bruce A @ 8831 elst Awe M Mew Hope MM 55425 1/1/1965 | M Hennepin 05 45 454 1016704 MEW HOPE P07
795 Anderson Dennis Harold @ 5916 Hillsboro Cir Mew Hope MM 55428 14/1939 M Hennepin a5 45 454 1143326 MEW HOPE P07
959 Anderson Karen Joann @ 6001 Boone Ave N Mew Hope MM 55423 1141944 |F Hennepin 05 45 454 1145788 MEW HOFPE P07
996 Anderson Kurt C @ 7659 60th Ave N Mew Hope MM 55423 11195 | M Hennepin 05 45 454 1295007 MEW HOFE P07
997 Anderson Ladon Margue @ 6001 Boone Ave N MNew Hope MM 55425 1/1/1938 Hennepin 05 45 454 1146666 MNEW HOPE P07
1024 Anderson Lois M @ 5916 Hillsboro Cir MNew Hope MM 55425 111941 | F Hennepin 05 45 454 1142151 MNEW HOPE P07
1106 Anderson Faul William @ 6116 Xylon Ave M New Hope [ 55425 111960 M Hennepin 05 45 454 1193035 NEW HOPE P07
1195 Anderson Stephanie Layne @ 9010 61st Ave M New Hope [ 55425 111967 |(F Hennepin 05 45 454 1254174 NEW HOPE P07
1203 Anderson Stewart A @ 5357 Boone Ave N MNew Hope MM 55425 1/1/1542 M Hennepin 05 45 454 1143327 MNEW HOPE P07
1204 Anderson Susan Ann @ 7659 60th Ave N MNew Hope MM 55425 111952 (F Hennepin 05 45 454 1294575 MNEW HOPE P07
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To save time in the future when you are entering the walk list results it’s a good idea to save the search query as a favorite, or to mass update the
list with an attribute (this is a better option if you think the data will change periodically). In my example | saved the search as a favorite as the

data wasn’t likely to change until the next election cycle.

To save the search, click the blue Advanced Functions button below the [Search] button in the upper-left, and then click the blue floppy disk icon.

2

<52 Search ., Reset | 4F New il | |:'f File » Edit ~ | 0 | Include Other Voters
Q% (=200 . EEEE« sQL |

Favorites | General | Address | Household Vote History | Attribute | Canvass | Poll | Relation | Lawn Sign | Contribute | Pledge | Event | Sales | Log | Admin| SQL |
1 \ 0 | [ Save search criteria as a "favorite” for later use. h
v @) At least one Inclu... Election Vote Partisan o
O A 11/06/2012-GENE... [Voted  ~ | Nt Partisar ~|
Omatleast [ <|of3 08/13/2013-PRIM... [Voted ~ | Not Partisar ~ |
. 08/12/2014 PRIMA... [voted Mot Partisar v |
11/04/2014GENER... [Voted [ Nt Partisar | Q

EE Edit | Sort fF Format - S3Wrap | &% Export % Print @ Summary [[] = |[E Pivet |

Last Name First Name Street Street City

Dloesn't Support Mot Home Supports Undecided Wants to Contribute Wants to Volunt

Abts Cari 8701 61st Ave N Mew Hope

Belisle loan 6056 Rhode Island Ave N Mew Hope I
W i i [ [ [ [ (B [

Aho Anita 5043 Hillsbora Ave N New Hope . . . .
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& TrailBlazer

Organbe.Leverage. Succeed. Walk List, Selectable Format — How to Create Paper Walk Lists with
Questions & How to Enter the Results in ‘Batch Mode’

Give the query a descriptive name and click [Save]. In my example | called my saved search “2017 walk list No1 — 1/3 general voters in New Hope
Precinct 7”.
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@ Z;le'i,gigzer Walk List, Selectable Format — How to Create Paper Walk Lists with
Questions & How to Enter the Results in ‘Batch Mode’

1. Create a descriptive name
for the search favorite.

@ Save Search Crteria as a "Favornta" -.

2017 Walk List Mol - 1,3 General Voters in New Hope Precit -

Private

Saved Search Mame Created Chwned By User

@ Missing Employer Qccupation aver 200 20091207
@Super Voters (Republicans 2016) 2016504421 Kristensaon, Joel
| | R Voters with Images 2003/06/08

45



http://www.trailblz.com/kb

& TrailBlazer

Organize.Leverage. Succeed. Walk List, Selectable Format — How to Create Paper Walk Lists with
Questions & How to Enter the Results in ‘Batch Mode’

When you need to reload the search in the future for entering the walk list results it will be stored in the Favorites tab.

<3 Search % Reset | 4k New o=k ¥ @ File - Edit - |« | SgInclude Other | Voters

eneral I Address | Household | Wote History | Adtribute | Canvass I Pall | Relation | Lawn Sign | Contribute

Favonte Searches

Missing Employer Occupation over 200
Super Voters [Republicans 2018)
Voters with Images

When you need

to reload the search
in the future for
entering the walk SE edit | Sort B Format - 53 Wrap | &} Export & Print (& Detail |[@ Summary [T] 3 | @ Pivot |
list results, it will S

be stored in the

‘Favorites' tab.
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& TrailBlazer

Organtze.Leverage. Succeed. Walk List, Selectable Format — How to Create Paper Walk Lists with
Questions & How to Enter the Results in ‘Batch Mode’

The next section walks through the steps to generate your walk list using the format and search you’ve created thus far, and how to record the
results as you go door-to-door.

#4 — Generate and Print the Walk List ‘Selectable Format’ and Begin Door Knocking

Once you're finished building the voter list you’ll need to load the format that contains the walk list questions (attributes) which was created in the
previous section.

Click [Format] > Select Saved...
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& TrailBlazer

Organize, Leverage. Succeed.

Walk List, Selectable Format — How to Create Paper Walk Lists with
Questions & How to Enter the Results in ‘Batch Mode’

After you've finished building the list you'll need to load the format that
contains the questions you created in the previous steps.

<3 Search M. Reset | ok New =B ¥ @ File ~ Edit ~ ) | g Include Other | Voters
QD

Favorites General | Address | Household | Vote History | Attribute | Canvass | Poll | Relation | Lawn Sign | Contribute | Pledge | Event | Sales | Log | Admin| SQL |

Name | Phone| E-Mail | Email Links | Profile | Work Demographics | User, Text | User, Dates | User, Decimal | Other |

Q.
==& Age Range: |ﬂ J e to |12'|] d Registration [< custom, according to dates below= v]
== . Date:
Birth Month: []gnure q B> E-
Gender; []gnure v] Vote Percentage: |ﬂ E" to |1Dﬂ E"

Head of Household

o

St Edit | B Sort [ Format (=3 Wrap | 9% Export {2 Print Summary [[] = | [E Pivot |

Voters [ 1643 record <System Format>

ol
o . ClLlons I Address Street Street City State Zip Eirth Gen- County D
|‘E’ Select saved | Type Code Date der
[ 3 93 rancis B701 61st Ave N MNew Hope MM 55428 1711965 | M Hennepin
94 b save e \New Hope 55428 1/1/1964 Hennepin
;,,@ Save A ct a previcu sl},r saved format to apply to this display grid
114 st g BUTE B TOTE IS TA I SE T Mew Hope |MN | 55428 1/1/1964 | F Hennepin 05
27T @ Assign as default... i @ 8043 Hillsboro Ave M MNew Hope MM 55428 141935 | F Hennepin 05
| |
o euben amue| illsboro Ave ew Hope ennepin
253 Ah Reub S | 6043 Hillsb Ave M Mew H rAM 55428 17141931 | M H i 05
rec isan ai uebec Ave ew Hope ennepin
341 Albrecht Ali Faith 6016 Quebec fve N Mew H MM 55428 1/1/1978 | F H i 05
345 Albrecht MMaralee A @ 5909 Cavell Ave M MNew Hope Il 55428 1/1/1942 Hennepin 05
= (T z
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@ Z;{E‘i,g!cgzer Walk List, Selectable Format — How to Create Paper Walk Lists with
Questions & How to Enter the Results in ‘Batch Mode’

Select the format that contains your walk list questions and then click [Select and Close].

@ Select Format

Format Mame Created |lsage

() <System Format>
352 2017 Walk List 03327 ||

@Candidate Support Wallc List 01195207
EEF Employer Occupation 06/10/2010
EEF) JAK DEFALLT 08/06/2014
EE7 Phone Bank - Support 11/22/2011
5 Walk List Support 05/27/2012

Details
2

Select | | Selectand Close | |2 Cancel |

Once the format and list of voters are in place, click the [Reports] button in the bottom-right.
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9 D&gﬁé!xgdzer Walk List, Selectable Format — How to Create Paper Walk Lists with
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«3sSearch . Reset | 9 New = File -~ Edit + | ) | $ Include Other | Voters

9
Favorites | General | Address | Houschold VoteMistory | Attribute | Canvass | Poll | Relation | Lawn Sign | Contribute | Pledge | Event | Sales | Log | Admin| SQL |
Q)
o @ At least one Inclu... Election Vote Partisan -
GF 11/06/2012-GENE... [voted  ~ Mot Partisar |
Olnatleast [ i3 08/13/2013-FRIM... [Woted + | not partisar ~ |
08/12/2014PRIMA... [Voted v |hot Partisar v |
11/04/2014GENER._ [voted | Not Partisar v| | |

Last Mame First Name Street City Doesn't Support Mot Home Supports Undecided ‘Wants to Contribute ‘Wants to Volunteer ‘Wants Yard Sign D

Abts Cari 8701 615t Ave M New Hope

Belisle Joan 5056 Rhode Island Ave N Mew Hope

Aho Anita 6043 Hillsboro Ave N New Hope

Aho Reuben 6043 Hillsboro Ave N New Hope

Albrecht Alison 5016 Quebec Ave N New Hope

Albrecht Maralee 5909 Cavell Ave N Mew Hope

Alexander Arnelda 5956 Ensign Ave N Mew Hope

Alexander Leo 5856 Ensign Ave M Mew Hope

Almstrom Rebecca 6064 Allan Cir Mew Hope

Almstrom Wayne 6064 Allan Cir Mew Hope

Amundsen Charles 6050 West Broadway Apt7 Mew Hope

Anderson Bruce 8831 Glst Ave M New Hope

Anderson Dennis 5916 Hillsboro Cir New Hope

Anderson Karen 6001 Boone Ave N Mew Hope

Anderson Kurt 7659 60th Ave N New Hope

[#1 | andersan ladon A001 Roone Sve B MNew Hone 7l |l [P [ [ |l [ o
B4, | | 0 | 0 | o [ o | 0 | 0 | 0 q
< | I p— ] »

Logon= Joel Kristenson |L—_| Save | |h@ Save and Close ’& Reports ]I[Gﬂ? New ] [@Canoel ]
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& TrailBlazer

Organtze, Leverage. Succeed. Walk List, Selectable Format — How to Create Paper Walk Lists with
Questions & How to Enter the Results in ‘Batch Mode’

Select Walk List, Selectable Format and click [OK].

@ Select a report to print m

Reports

Simple List
& List with User Fields
List with Motes
Simple Volunteer List
Volunteer List
Fundraising List
Labels {Use Avery 5160)
Labels {Use Aveny 5160)/Mick Name Option
Labels Mame buitt by list-Combined House or by last name and address (Use Awver
Labels Household and Envelope Mame (Use Avery 5160)
Mame Badge - First + Last Mames + Employer (Use Avery 5352)
Mame Eadie - First + Last Names iUse ﬁvﬁ % i
Walk List, Selectable Format
Walle List, Vater Histony
[Legacy] Walk List, Simple, 2 Checked
[Legacy] Walk List, Simple, 5 Checked
[Legacy] Walk List, Wide, 5 Chechked
[Legacy] Walk List, Satinder
[Legacy] Walk: List, Custom
[Legacy] Walk List, & Attributes
[Legacy] Walk List, Wide b Attributes
[Legacy] Wallc List, Attributes Yukon Options
[Legacy] Walk List, & Checked with barcode
[Legacy] Walk: List, Barcoded General Pumpose

2
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> Z;{El'i.é!cgzer Walk List, Selectable Format — How to Create Paper Walk Lists with
Questions & How to Enter the Results in ‘Batch Mode’

Create a Report Title, configure your options, and then click [OK]. In my example | called mine 2017 Walk List — New Hope P-07, and | left the
checkbox settings as default (Print grid lines, and Odd/even order). You can of course play around with these settings to see what suites you best.

Walking List =]

Heading -
‘Report Title: © 2017 Walk List - New Hope P07| ==

Legend Text 1:
Legend Text 2:
Legend Text 3:
Legend Text 4:

Detail

Format: < displayed format=>

Options 2. Configure your
Print grid lines

Odd/even order options"
[] Mew page when oddleven type changes

[] Mew page on street change

[] Start new street on odd page

[7] Skip household when phone numbers missing

3
@ ok ||@cancel |
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& TrailBlazer

Organbe.Leverage. Succeed. Walk List, Selectable Format — How to Create Paper Walk Lists with
Questions & How to Enter the Results in ‘Batch Mode’

Verify everything looks good on paper and then click [Print] in the top-left, select your printer, and print the walk lists. My finished example is
below with details.
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& TrailBlazer

Organize. Leverage. Succeed.

Walk List, Selectable Format — How to Create Paper Walk Lists with
Questions & How to Enter the Results in ‘Batch Mode’

Example of a walk list ready for distribution. By default it will group voters by street name,
and street number so they can walk their routes efficiently.

Groups
members N\
of a house-
hold together.

Ny

i Print | J® 2 |Bgless g8 More | QD 1 @ @ | £E Print Settings

_ Details about the walk list will print at the top (name, time, etc.).
& TrailBlazer —
2017 Walk List - New Hope P-07 Page: 1 of 71- 3/7/2017 9:55 AM
Last Name First Name Doesn't Support MNot Home Supports Undecided Wants to Contribute Wants to Volunteer Wants Yard Sign
5404 58th Ave N, New Hope, MN 55428 [Precinct Code=2330, Precinct Name=NEW HOPE P-07]
Engle Elvina O | O ] [l O O
Engle Roger O ¥ O [l Fl ¥ [
8412 58th Ave N, New Hope, MN 55428 [Precinct Code=2330, Precinct Name=NEW HOPE P-07]
Dionne Carol O O O O O | O
7900 59 1/2 Ave N, New Hope, MN 55428 [Precinct Code=2330, Precinct Name=NEW HOPE P-07]
Disch Kim Il Il Il ¥ 1 IF 1
Disch PJ O ] [l ] O O ]
7910 59 1/2 Ave N, New Hope, MN 55428 [Precinct Code=2330, Precinct Name=NEW HOPE P-07]
Cotter Kathleen O ] [ [N O O 1
7920 59 1/2 Ave N, New Hope, MN 55428 [Precinct Code=2330, Precinct Name=NEW HOPE P-07] |
Stiles Gertrude | | . [l | O | r
Stiles James | ] | O |
7940 59 1/2 Ave N, New Hope, MN 55428 [Precinct Code=2330, Precinct Name=NEW HOPE P-07]
Ruha David O O O |l [l | O
Ruha Elizabeth O | Fl [ O O [
7941 59 1/2 Ave N, New Hope, MN 55428 [Precinct Code=2330, Precinct Name=NEW HOPE P-07]
Eull Thomas Ll Ll ] Ll ] O 1
7931 59 1/2 Ave N, New Hope, MN 55428 [Precinct Code=2330, Precinct Name=NEW HOPE P-07]
MNvce Amanda ¥l ] ] 1 F ¥l ]
Nyce Catherine | [l ] [l | [l
Nyce David | ) Ll 0 | Ll

Adliia-blblowi-bopor- Mt 643 5—firooinotcodondiitmoainotdl NEM-HORE-R-07
Reinert Michael O O O [l 0 O O
7901 59 1/12 Ave N, New Hope, MN 55428 [Precinct Code=2330, Precinct Name=NEW HOPE P-07]
Bishop Delrico | A | 1 F IF d L
Schafer Bradley ] ] ] ] ] | ]
7900 59th Ave N, New Hope, MN 55428 [Precinct Code=2330, Precinct Name=NEW HOPE P-07]
Mendoza Gloria | F O | [l O 0
7918 59th Ave N, New Hope, MN 55428-2761 [Precinct Code=2330, Precinct Name=NEW HOPE P-07]
Bare Andrew O O a Il il O Il
Bare Caitlin [ ¥ ¥l | Il Il [
Bare Nathan O O O O O O O
7070 RGth Ava N Naw Hana MN SRAZR [Pracinct Cada=272 Pracinet Nama=NFW HOPFE P 071 S
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& TrailBlazer

Organtze.Leverage. Succeed. Walk List, Selectable Format — How to Create Paper Walk Lists with
Questions & How to Enter the Results in ‘Batch Mode’

Distribute the paper walk lists to your door-knockers, teach them how to fill out the answers, how to be polite as they knock on doors, etc. Below
is an example of a walk list with the results filled in. You may want to send each group of walkers out with a map of the area they’re canvassing as
well as a smart phone or tablet with the internet to pull up their location on something like Google Maps so they can canvass more efficiently.
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& TrailBlazer

Organize, Leverage. Succeed.

Walk List, Selectable Format — How to Create Paper Walk Lists with
Questions & How to Enter the Results in ‘Batch Mode’

Example walk list with the results filled in - ready to be entered back into Trail Blazer.

g Print | J& & Eg Less g8 More 0 @ 5 Q 0 f ,;;Print Settings
& TrailBlazer
2017 Walk List - New Hope P-07  Page: 5 of 71- 3/7/2017 9:55 AM
Last Mame First Name Doesn't Support Not Home Supports Undecided Wants to Contribute Wants to Volunteer Wants Yard Sign
9011 60 1/2 Ave N, New Hope, MN_55428-3066 [Precinct Code=2330, Precinct Name=NEW HOFPE P-07]
Berger Jennifer % | ] .| | [l
Berger Jonathan O ] 4| | Ol
5931 60 1/2 Ave N, New Hope, MN 55428 [Precinct Code=2330, Precinct Name=NEW HOPE P-07]
Urailes Germania 1 [ b [ 1 1 >
Urgiles Jose O £ P | | ] Ll
8921 60 1/2 Ave N, New Hope, MN 55428 [Precinct Code=2330, Precinct Name=NEW HOPE P-07]
Buker Donald L] E Ll L] Ll Ll L]
Buker Iary ] Fi ] Fi Fi )
5911 60 1/2 Ave N, New Hope, MN 55428 [Precinct Code=2330, Precinct Name=NEW HOFE P-07]
Tailor Jayesh 4| Fl O ] Il [l [l
5901 60 1/2 Ave N, New Hope, MN 55428 [Precinct Code=2330, Precinct Name=NEW HOPE P-07] E
Boitz James ¥l [ il 1 X ¥
Boitz Sara Lee Fl F L || % |
8831 60 1/2 Ave N, New Hope, MN 55428 [Precinct Code=2330, Precinct Name=NEW HOPE P-07]
Athmann Beverly [] | | [ L L]
Athmann Brittany ) Q Fl ] F]
Athmann Duane | ] Ll [l Ll L]
Athmann Travis w ] Fl ] F]
5621 60 1/2 Ave N, New Hope, MN 55428 [Precinct Code=2330, Precinct Name=NEW HOFPE P-07]
Eliason Carol | ] ] [l ]
Eliason Karl 4| [] ] i
Eliason Ray Fl R | ] O [l
55801 60 1/2 Ave N, New Hope, MN 55428 [Precinct Code=2330, Precinct Name=NEW HOPE P-07]
Magle Morma [l ] ] p_ | x g
8711 60 1/2 Ave N, New Hope, MN 55428 [Precinct Code=2330, Precinct Name=NEW HOPE P-07]
Melson Glenn [l il m F] | Fl X
8541 60 1/2 Ave N, New Hope, MN 55428 [Precinct Code=2330, Precinct Name=NEW HOPE P-07]
Gorsky Kenneth % O ] [l O l
Gorsky Martha Fi | |l 4| Ll
8533 60 1/2 Ave N, New Hope, MN 55428 [Precinct Code=2330, Precinct Name=NEW HOPE P-07]
Clough Harold 1 [ X [ |l [l Ol
8525 60 1/2 Ave N, New Hope, MN 55428 [Precinct Code=2330, Precinct Name=NEW HOPE P-07]
Hamilton Shaun 1 ] | g 4l I I8
[P PO T e ] ™ | ] |



http://www.trailblz.com/kb

& TrailBlazer

Organtze.Leverage. Succeed. Walk List, Selectable Format — How to Create Paper Walk Lists with
Questions & How to Enter the Results in ‘Batch Mode’

The final section shows how to enter the walk list results back into the database in batch mode.

#5 — Re-Enter the Walk List Results in ‘Batch Mode’ (Directly into the Grid)

Navigate to the Voters list.
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Organtze, Leverage. Succeed. Walk List, Selectable Format — How to Create Paper Walk Lists with
Questions & How to Enter the Results in ‘Batch Mode’

—

@) Settings Help

Application Menu &«
i

Tasks =

B Dashboard
[» % Committee
5 Calendar/Tasks
[ % Canvassing
4 % Voter
Yoters -‘—

Minnesota Voter List
@ Addresses
@ Households
Yoter Relationships
FJ Lawn Signs
€z shared Databases
|- @@ Contributions/Pledges
5 7 Product Sales
[» @ Logs
7 Polling
[ @ Communications
[ 5 Financial
[ % Disclosure
i &g System Manager

Load your saved search query from under the Favorites tab (created in the previous sections).
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@ Iigﬂé.!gmzer Walk List, Selectable Format — How to Create Paper Walk Lists with
Questions & How to Enter the Results in ‘Batch Mode’

Load the same list you used for the walk list.

<o Search Y. Reset | New |[S|E o | ) ¥ # (2| File - Edit + | ) | Sginclude Other | Voters

Favorites | General | Address | Household | Vote History | Attribute | Canvass | Poll | Relation | Lawn Sign | Contribute | Pledge | Event | Sales | Log | Admin| SGL |

% | Favorite Searches
=1l
Super Voters (Republicans 2016) LS
Voters with Images o
]
Vater List Load =

Records to Load
Search found 1,643 records, Of these, load:

E8 Edit | Sort B Format ~ 53 Wrap |Eﬁ I
: 1o oA |

Last First “ Zip Birth Gen- Reg
D MName - Mame I Frogress 2 | te Code Date der County CD 3D LD Id
0 L - :
‘wiaiting for user input...

3
@ ok ||@cancel |
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& TrailBlazer

Organbe.Leverage. Succeed. Walk List, Selectable Format — How to Create Paper Walk Lists with
Questions & How to Enter the Results in ‘Batch Mode’

Load the Format that contains the walk list questions you used, and that has the updateable attribute columns (created in section #2).

Start by clicking [Format] > Select Saved...
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& TrailBlazer

Organize.Leverage. Succeed. Walk List, Selectable Format — How to Create Paper Walk Lists with
Questions & How to Enter the Results in ‘Batch Mode’

I] <32 Search % Reset | 4b New = | oF @ File » Edit ~ | ¢ | 8gInclude Other | Voters

Favorites | General | Address | Household | Vote History | Afiribute | Canvass | Poll | Relation | Lawn Sign | Contribute | Pledge | Event | Sales | Log | Admin| SGL |

d

4

Missing Employer Occupation over
Super Voters (Republicans 2016) ‘..
Voters with Images p

- ADOIESS  ghreet Street 2 City State Eigd . g:g: g:? County CD SD LD f:fg

’_ E Select saved.. _F_ 'q’\ 8701 61st Ave N Mew Hope ’W 55425 1/1/1965 ’M_ Henn... ’FIF’K 1487976
bk Save L.l P |s70161stave N Mew Hope  |MN | 55428 1/1/1964 | F Henn.. |05 |45 [454 | 1409304
164971 “@ Save As,., [ Select a previously saved format to apply to this display grid ]ope MN | 55428 1/1/1992 Henn.. |05 |45 |454 | 4718414
277 @ Assign as default... L @ 6043 Hillsboro Ave N Mew Hope MM | 55428 1/1/935 | F Henn.. |05 |45 |45A 1149831
283 Ahao Reuben S. @ 5043 Hillsboro Ave N MNew Hope MM | 55425 1474931 | M Henn... |05 |45 |[454 1148832
341 Albrecht Alison (Feee @ 6016 Quebec Ave N MNew Hope MM | 55425 1/1/978 |F Henn... |05 |45 |[45A4 1507235
348 Albrecht Maralee A @ 5909 Cavell Ave N Mew Hope MM 55428 111942 Henn... |05 45 454 1152452
375 Alexander Arnelda J @ 5956 Ensign Ave M MNew Hope MM | 55425 1/1/1936 Henn... |05 |45 |[454 1142149
384 Alexander Leo E @ 5956 Ensign Ave M Mew Hope MM | 55425 1/1/1932 | M Henn.. (05 |45 |[454 1142150
518 Almstrom Rebecca R.. @ 6064 Allan Cir Mew Hope MM | 55425 1/1/1960 | F Henn.. |05 |45 |454 3516920
519 Almstrom Wayne D... @ 064 Allan Cir MNew Hope MM | 55425 1/1/1963 | M Henn... |05 |45 |[454 1595535

I 160266 Amorde Debra M.. 5941 Gettysburg Av... Mew Hope MM | 554253036 111972 Henn... |05 |45 |[454 1358545
600 Amundsen Charles R... @ 6050 West Broadway | Apt7 Mew Hope MM | 55425 11/1924 | M Henn... |05 |45 |454 11535841
163655 Anderkay Artemus G... 6116 Winnetka Ave M MNew Hope MM | 55425 1/1/1975 Henn... |05 |45 |[45A& | 4250407
164682 Anderson Barbara e 9000 60 1/2 Ave N Mew Hope MM | 55425 1/1/1968 Henn... |05 |45 |45A 3380513
711 Anderson Bruce A @ 8831 61st Ave N Mew Hope MM | 55425 1/1/1965 | M Henn... |05 |45 |454 1016704
165469 Anderson Caryn M... 6116 Xylon Ave M MNew Hope MM | 55425 1/1/1990 Henn... |05 |45 |454 4327527
795 Anderson Dennis H... @ 5916 Hillsboro Cir Mew Hope MM 55428 111939 | M Henn... |05 45 454 1143326
161424 Anderson Diane (T 6054 West Broadway | Apt 24 Mew Hope MM | 55425 1/1/1948 Henn... |05 |45 |454 2633579
168045 Anderson Emma Jo 6082 Zealand Ave N MNew Hope MM | 55425-2751 1/1/1987 Henn... |05 |45 |45A& | 4256273
157955 Anderson Erik C... 6071 Ensign Ave M Mew Hope MM | 55425 1/1/1971 Henn.. |05 |45 |454 3831840
157956 Anderson Jill &071 Ensign Ave M Mew Hope MM | 55425 1/1/1958 Henn... |05 |45 |[454 1108087

- p— - B - g - N - a - S B
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@ Z;{;gilé!xgdzer Walk List, Selectable Format — How to Create Paper Walk Lists with
Questions & How to Enter the Results in ‘Batch Mode’

Select the format and click [Save and Close].

9 Select Format

Format Mame Created

) «System Format
ekl o

@Candidate Support Walk List 011597207
EEF) Employer Occupation 06/10/2010
EER JAK DEFAULT 08/06/2014
EE7 Phone Bank - Support 11/22/2011
B Walk List Support 05/27/2012

Deetails
2

Select | | Selectand Close | [0 Cancel |
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Organbe.Leverage. Succeed. Walk List, Selectable Format — How to Create Paper Walk Lists with
Questions & How to Enter the Results in ‘Batch Mode’

It will be a lot easier to re-enter data if you add in two more columns to the format for street name, and street number. This will allow you to sort
the list to group voters by location.

Click [Format] > Columns...
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Organize.Leverage. Succeed. Walk List, Selectable Format — How to Create Paper Walk Lists with
Questions & How to Enter the Results in ‘Batch Mode’

<3 Search %, Reset | 4k New = b o @ File + Edit ~ | ) | S Include Other | Voters |

o
Favonies | General I Lddress I Household | Vaote Histony | Attribute | Canvass | Paoill | Relation | Lawn Sign | Contribute | Ple
Q
% Favorite Searches
2017 Walk List Mol - 1/2 General Voters in Mew Hope Precinct 7 =
Miszing Employer Occupation over 200 i
Super Voters (Fepublicans 2016) b.
Voters with Images o)
el

TS

=8 Edi -5 ry ' ' = Pi
:E Edit ﬁﬁort @Format =3 Wrap EExpﬂ-rt &Prmt |§| Summary D] B PI‘-I'Dt |

2017 Walk List

Voters [ 1643 record
Columns... |
= 3 elect saved.., S —
| Abt [Add or remove columns, apply formatting, or specify column attributes, |_

apts | b Save 701 61t Ave N Mew Hope
apts | SaveAs.. 701 615t Ave N New Hope
Aho B Assign as default... D43 Hillsbaro Ave N Mew Hope

|
Aho Reuben B043 Hillsboro fve N Mew Hope
Albrecht Alison 6016 Quebec Ave N Mew Hope
Albrecht Maralee 5909 Cavell Ave M MNew Hope
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Organbe.Leverage. Succeed. Walk List, Selectable Format — How to Create Paper Walk Lists with
Questions & How to Enter the Results in ‘Batch Mode’

In the lower-left of the Columns screen, click on the ‘Address [Home]’ joined table. Then scroll down the right-hand list of columns, check the
boxes for Street Name and Street Number and click [OK].
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Organtze, Leverage. Succeed. Walk List, Selectable Format — How to Create Paper Walk Lists with
Questions & How to Enter the Results in ‘Batch Mode’

Ta
B) Column Selection

Columns | Attributes I Vaote History | Format |

Table Columns [Address [Home]]
% = PublicServiceComm
e School
School Sub / Board
sD
Soil Wniater
State
State Board/BESE
Street
Street2
Streetd
StreetCity StateZipBlock
Joined Tabl [T et Sl 2
Streethame
E StreetMumber
= Clote

- Raree (o e UseCnunt
a [ Address [Home] ValidAddress
\ward
Zip Code
ZipCode5
) Address [Mailing ZipCodebVirtual
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The two new columns will be added to the far right of the grid.

Click on each of the column titles and drag them to the left on the grid, and then release them. My example is below — this will make it easier for
your data entry. You can save this format for future use if you’ll be entering data again in the future.
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Q

Q

<32 Search %, Reset | 4k New e File + Edit - | | 8pInclude Other | Voters

Favorites | General | Address | Household | Vote History | Attribute | Canvass | Foll | Relation | Lawn Sign | Coniribute | Pledge | Event | Sales | Log | Admin| SQL |

1]
@

Favaorite Searches
7 Walk List No1 - 1/3 General Voters in New Hope Precinct 7 w3
| Missing Employer Oceupation over 200 i
Super Voters (Republicans 2016) .
Woters with Images Yo
il

Move these columns to the left by click-and-draging
on the column titles and then releasing them where
you want them to go in the grid.

—

EE Edit @ Sort @ Format - =3 Wrap Bﬁ Export & Print
Voters [ 1643 records found ]

Last Name 4 First Name

3 Abts Brian 00008701 61st Ave N I 3701 61st Ave N

Street
Mumber

Street Mame

& Summary (1] 5 | EP

Street ;t’“t City

Doesn't Support Mot Home Undecided Wa

| ® [ = [ = [ = [

Supports

Mew Hope

Abts Cari 00008701 blst Ave N B701 61st Ave N Mew Hope
Abts Dylan 00008701 61st Ave N B701 61st Ave N New Hope
Aho Anita 00006043 Hillsboro Ave N £043 Hillsboro Ave M Mew Hope
Aho Reuben 00006043 Hillsboro Ave N 5043 Hillsboro Ave M Mew Hope
Albrecht Alison 00006016 Quebec Ave N 5016 Quebec Ave N New Hope
Albrecht Maralee 00005909 Cavell Ave N 5909 Cavell Ave N New Hope
Alexander Arnelda 00005956 Ensign Ave N [F956 Ensign Ave N Mew Hope
Alexander Leo 00005956 Ensign Ave N FSSG Ensign Ave N Mew Hope
Almstrom Rebecca 00006064 Allan Cir Eos4 Allan cir Mew Hope
Almstrom Wayne 00006064 Allan Cir 5064 Allan Cir Mew Hope
Amorde Debra 00005941 Gettysburg Ave N P241 Gettysburg Ave N Mew Hope
Amundsen Charles 00006050 ‘West Broadway 050 West Broadway Apt7 Mew Hope
Anderkay Artemus 00006116 Winnetka Ave M 5116 Winnetka Ave N Mew Hope
Anderson Barbara 00009000 601/2 Ave N b000 60 1/2 Ave N New Hope
Andersan Bruce 000085831 61st Ave N B531 61st Ave N New Hope
Anderson Caryn 00006116 Xylon Ave N 5116 Xylon Ave N Mew Hope
Anderson Dennis 00005916 Hillsbara Cir 5916 Hillsboro Cir Mew Hope
Anderson Diane 00006054 West Broadway E054 West Broadway Apt 24 Mew Hope
Andersan Emma 00006082 Zealand Ave N [p082 Zealand Ave N Mew Hope
Anderson Erik 00006071 Ensign Ave N Eﬂ?l Ensign Ave N Mew Hope
Anderson lill 00006071 Ensign Ave N bﬂ?l Ensign Ave N Mew Hope
1 =11 .o I N (N ——— - - T =l =l =l =l 1 3
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Next you’ll want to sort the grid to group the voters by street. Click the [Sort] button the list tool strip.
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| <3 Search %, Reset o New = = File = Edit =

@

Favorites. | General | Address | Household | Vote History | Attribute | Canvass | Poll | Relation | Lawn Sign | Contribute | Pledge | Event | Sales |
Q

% | Favorite Searches
2017 Walk List No1 - 1/3 General Voters in Mew Hope Precinct 7

&Include Other | Voters |

.,
4

,
+

Mis=sing Employer Cecupation over 200
Super Voters (Republicans 2018) ‘.-
j:}

Voters with Images

Fl Format ~ 53 Wrap BE Export %Print @ Summary ED E [E Pivot |

Voters [ 1643 records found ]
Specify sort of dlsplay (columns order, etc.).

Last M3 Number Street Mame Street Street City Doesn't
I_ Abts Brian 00008701 61st Ave N 8701 61st Ave N Mew Hope
Abts Cari 00008701 Glst Ave N 3701 61st Ave N Mew Hope
Abts Dylan 00008701 B6lst Ave N 8701 61st Ave N MNew Hope
Aho Anita 00006043 Hillsboro Ave N 6043 Hillsboro Ave N Mew Hope
Aho Reuben 00006043 Hillsboro Ave N 6043 Hillsboro Ave N Mew Hope
Albrecht Alison 00006016 Quebec Ave N 6016 Quebec Ave M Mew Hope
Albrecht Maralee 00005509 Cavell Ave N 5909 Cavell Ave N Mew Hope
Alexander Arnelda 00005958 Ensign Ave N 5956 Ensign Ave N Mew Hope
Alexander Leo 000053956 Ensign Ave M 5956 Ensign Ave M MNew Hope
Almstrom Rebecca 00006064 Allan Cir o604 Allan Cir Mew Hope
Almstrom Wayne 00006064 Allan Cir 6064 Allan Cir Mew Hope
Amorde Debra 00005941 Gettysburg Ave N 5941 Gettysburg Ave N Mew Hope
Amundsen Charles 00006050 West Broadway 6050 West Broadway Apt 7 Mew Hope
Anderkay Artemus 00006116 Winnetka Ave N 6116 Winnetka Ave N Mew Hope
1 Anderson EBarbara 00009000 60 1/2 Ave M 9000 60 1,2 Ave N Mew Hope
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Under the Columns tab, click Street Number & Street Name, and then click [OK].
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@- Sort Selection

Cnlml

<include column=

ID
Last Mame
[—] Lro g f o

| Strest Mumber
Street Name

Address Type
Street
Strest 2

City

Column

Descending

Street Mumber

The voters will now be grouped together to make it easier to re-enter your walk list results. My example is below.
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Click the [Edit] button so that the attribute (question) columns turn green (which means they are updatable in the grid view).
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<32 Search Y, Reset | 4k New =T File - Edit + | ) | S Include Other | Voters

Favorites | General | Address | Household | Vote History | Attribute | Camvass | Foll | Relation | Lawn Sign | Contribute | Pledge | Event | Sales | Log | Admin| SQL |

Favorite Searches

»
i

The list will now be grouped by street number
®  and street name.

columns turn green allowing you
to input data in the grid view.

£ Sort @ Format - =3 Wrap DE Export & Print

wuieis | 4043 records found |

Last Name

First Name

Street
MNumber

< Street Name

man Drer 00005700 Boone PI

Street

5700 Boone Pl

Street .
2 City

—

Doesn't Support

Mot Home

Supports

Undecided

The columns turn green after you
click [Edit] and you can begin
checking off the answers from
the paper walk lists, and saving
as you go.

‘Wants to Contribute Wants to Volunteer Wants Yard Sign

KNOWLEDGE BASE www.trailblz.com/kb

Schneider Joseph 00005716 Boone Pl 5716 Boone PI MNew Hope
Schneider Michelle 00005716 Boone Pl 5716 Boone Pl MNew Hope
Tysan Andrea 00005732 Boone Pl 5732 Boone Pl MNew Hope
Ceynar Barbara 00005740 Boone Pl 5740 Boone PI Mew Hope
Ceynar Marvin 00005740 Boone Pl 5740 Boone PI MNew Hope
Livingston Barb 00005748 Boone Pl 5748 Boone Pl Mew Hope
Arndt Anne 00005756 Boone Pl 5756 Boone PI Mew Hope
Stiglicz Debbie 00005756 Boone Pl 5756 Boone Pl Mew Hope
Stiglicz Mark 00005756 Boone Pl 5756 Boone PI Mew Hope
Erickson Mark 00005762 Boone Pl 5762 Boone Pl Mew Hope
Skaaden Betty 00005774 Boone Pl 5774 Boone Pl Mew Hope
Goble Lori 00005777 Yukon Ave N 5777 Yukon Ave N Mew Hope
Goble Vernon 00005777 Yukon fve M 5777 Yukon fve N Mew Hope
Gunia Jo 00005781 Yukon Ave N 5781 Yukon Ave N New Hope
Gunia Lean 00005781 Yukon Ave N 5781 Yukon Ave N New Hope
Wolfgram Carol 00005732 Boone Pl 5782 Boone Pl MNew Hope
Waolfgram Gerald 00005752 Boone Pl 5752 Boone Pl Mew Hope
Gurhalt James 00005758 Boane Pl 5788 Boone PI New Hope
Stage Michael 00005300 Boone Ave N 5800 Boone Ave N Mew Hope
Stage Rosemary 00005300 Boone Ave M 5800 Boone Ave N Mew Hope
Barrera Efren 00005300 Decatur Ave M 5800 Decatur Ave M MNew Hope
Barrera Herlinda 00005300 Decatur Ave M 5800 Decatur Ave M MNew Hope
[¥] | Barrera Ruben 00005800 Decatur Ave N 5800 Decatur Ave N MNew Hope [T I [l [l I [l [l
[Z)ES 0 0 0 0 0 0 0
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Begin enter the walk list results and click [Save] in the bottom-right as you go. The columns will provide totals at the bottom so you can begin to
get an idea of the results. My finished example is below.
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;& Street Name Street 3 i Doesn't Support Mot Home Supports Undecided ‘Wants to Contribute ‘Wants to Volunteer ‘Wants Yard Sign

Boone Pl 5700 Boone Pl
Boone Pl 5716 Boone PI

Boaone Pl 5716 Boone Pl
Boone PI 5732 Boone Pl
Boone Pl 5740 Boone Pl
Boone Pl 5740 Boone PI

Boone Pl 5743 Boone PI
Boone PI 5756 Boone PI
Boone Pl 5756 Boone Pl
Boone Pl 5756 Boone PI

=
:
R
-
W
=

]
<]
]
]
]
]
]

Boone Pl 5762 Boone Pl
Boone PI 5774 Boone Pl
Yukon Ave M 5777 Yukon Ave M
Yukon Ave N 5777 Yukon Ave N

|
:
!
T
i
it

[
Bl
=
Bl
<]
<]
=

Yukon Ave M 5781 Yukon Ave N
Yukon Ave M 5781 Yukon Ave N
Boone Pl 5782 Boone Pl
Boone Pl 5782 Boone PI

it
:
.
T
i
it

]
]
=
]
<]
]
<]

Boone Pl 5788 Boone Pl
Boone Ave N 5800 Boone Ave M
Boone Ave N 5800 Boone Ave N
Decatur Ave N 5800 Decatur Ave N

Decatur Ave N 5800 Decatur Ave N

00 Decatur Ave N 5800 Decatur Ave N

I Y A [T T

e
118
i
1
(1
e

KNosva:Sg tglg Ewalktlislt resullg and save as you go. The bottom
of each coltmin wifl provide a tally so you can get a good
idea of who supports the candidate, who doesn't, etc.
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Take a look at the related resources below for quick links to many other videos and articles related to this topic.

0009

Trail Blazer

- YouTube Channel
- Knowledge Base Articles
- 3rd Party Resources
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Related Resources

Article: Mobile Base Camp — How to Create and Run a Mobile Canvassing (Walk) List

Article: Mobile Base Camp — How to Setup and Use the Mobile Poll Watching App

Article: Tips and Tricks for using Mobile Base Camp — Add Shortcuts to your Home Screen, Adjust Device Settings to Keep the Screen on, and More
Article: Add Attributes, Attribute Dates, and Attribute Notes to the Grid by Formatting them in as Columns

Article: How to Create Attribute Folders and Attribute Items (Customer Categories)

Article: How to Delete an Attribute Folder and Attribute Items (Custom Categories)

Article: Save and Load a Search Query as a (Dynamic) Search Favorite

Article: SQL Wildcards

Article: Save and Load a Search Query as a (Dynamic) Search Favorite

Article: How to Mass Update a List of Contacts with an Attribute Item

Video: Canvass Your Neighborhood With Our Mobile Canvassing App

Video: Walk Lists — Using Format Display

Video: Reporting 101 — Political — Contribution reports & Walk Lists

Video: Mappoint — Select Houses to Walk By Drawing

Video: Getting Started 102 Beginning Queries - Nonprofit

Trail Blazer Live Support

© Phone: 1-866-909-8700
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® Email: support@trailblz.com
E? Facebook: https://www.facebook.com/pages/Trail-Blazer-Software/64872951180
B Twitter: https://twitter.com/trailblazersoft

* As a policy we require that you have taken our intro training class before calling or emailing our live support team.

Click here to view our calendar for upcoming classes and events. Feel free to sign up other members on your team for the same training.

* After registering you’ll receive a confirmation email with the instructions for how to log into the GoToMeeting session where we host our live
interactive trainings.

* This service is included in your contract.
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